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            Converting a single-page pdf into magazine-style spreads … in Acrobat!


            
                By 
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                 | 
                Published 
                November 3, 2018

                            


            
                When I send magazine pages to the printer, I do so as single-page pdf files with full bleed. Once the issue has been soft-proofed and approved, I take all the single-page PDF files and put them together to form one composite cropped-to-trim PDF for archiving, as you see to the left.

Our magazine website is going through a major overhaul, including making the magazine available for online subscriptions. As a result, I was asked to provide PDF files in spreads, like a magazine would really appear to anyone picking up a physical copy to read.

Should be easy, right?

Not according to the internet! I spent hours darting into and out of online forums, trying every menu I knew in Acrobat, and could not figure it out for the life of me. I didn’t want to create a flip-page e-reader, and I didn’t want to import the PDF to InDesign and re-export as spreads. I just wanted to click a button in Acrobat, and turn my single-page PDF into something more closely resembling a magazine.

Eventually I stumbled upon a forum that gave me enough of a hint that I was sent in the right direction, and able to figure out how to make this work. And it is easy! I’m sharing it here, with a handy-dandy date at the top of the post so you know when this information was shared, unlike some of these online forums that may be cobwebbed remnants from bygone eras of the late ’90s, when PDFs were a new technology.

I’m using Acrobat Pro DC on a Mac, and here’s how to convert your single-page PDF into an online “magazine” view.

1. Open the pdf you want to convert



2. Go to File > Properties

3. In the Document Properties window, click on the “Initial View” tab



4. Go to the Page Layout drop-down and select Two-Up Continuous (Cover Page)

(this will make it so your front cover is a separate one-page right-hand view – and subsequently your back page is a separate one-page left-hand view – and your next two pages open as a spread)

5. Save As – save your document with a new name

6. Close the document

7. Open the renamed document



Voila! Your single-page PDF is now displayed in more of a magazine style, in spreads, like the designer originally intend.

                            


            
                This entry was posted in Print Production and tagged acrobat, conversion, how-to, magazine, pdf, print production, publishing.
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            Vic June 15, 2020 at 5:00 pm #

                        
                Cannot thank you enough!!!!

Thank you! Thank you! Thank you! …
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            Kippy Spilker June 18, 2020 at 1:31 am #

                        
                You are so welcome, Vic – it makes my day that this blog was able to help someone. 🙂
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            Robert July 5, 2020 at 1:16 pm #

                        
                Hello, I’m using Acrobat Pro DC on a Mac and this is a great tip thank you. I have been looking everywhere for this solution. Can I also add that I tried this a few times and the bleed was still showing so I had to go a step further.

To remove the bleed area I went to edit pdf>crop pages tool, drew a box over the trim area on page 1, double clicked the crop box area which brought up ‘Set Page Boxes’ window and selected ‘All’ in the page range.

This gave me the magazine style spread without bleed exactly like your example.
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            Robert July 5, 2020 at 1:53 pm #

                        
                Ah sorry please ignore my comment, I see you crop the pages before combining to spreads.
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            Kippy Spilker July 5, 2020 at 11:30 pm #

                        
                No problem whatsoever, Robert! I’m going to leave your comment because you never know – someone else might miss that step, too, and your comment might help them. 🙂 I’m so glad this post could help you with what you’re working on.

            

        

        Reply
    





	
    
         

        
            denisab January 8, 2021 at 1:05 am #

                        
                Hello, first of all I want to thank you Kippy from all my heart for this, I have been looking to solve this issue for a long time now. Also Robert I have the same problems regarding the bleed, I tried following your steps but it simply does not work, I cannot seem to manage to draw this box over the trim area. Is there any alternative?

Thank you to everyone explaining this you saved me!!
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            Kippy Spilker January 8, 2021 at 1:23 am #

                        
                Hi Denisa (? Guessing at your name – sorry if I got it wrong). Did you see Robert’s follow-up comment about cropping prior to combining to spreads? Is that possibly the problem? If not, let me know what’s happening and I’ll see if I can recreate and help. 🙂
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            Denisa January 8, 2021 at 1:56 pm #

                        
                Hello and thank you so much for answering Kippy! I tried to follow but I cant manage to take out the bleed area.. I tried both before and after converting to spreads but to no success. Is there any video tutorial you could perhaps recommend?

Thank you again!

ps: Yes it was a spelling mistake my name is Denisa and its nice to meet you!
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            Kippy Spilker February 5, 2021 at 4:19 pm #

                        
                I’m so sorry, Denisa, I didn’t see your response come in! Oof, looks like I’ve missed a few. I’m not sure I understand what you meant about taking out the bleed area, and since I’m almost a month late in responding, maybe it’s too late now? If not, let me know what you mean and I promise I’ll pay better attention and try to help!

            

        

            














	
    
         

        
            Paul September 30, 2020 at 12:00 am #

                        
                Great workaround Kippy, thanks very much. I was wondering if it’s possible to go one step further. I have a 4 page pdf from an Illustrator file, which I need to create a 2 page spread for the printer. Using your process I have created that. I open it and see the 2 spread made from page1/2 and 3/4. When I go to print it, it shows the separate pages on the 8.5 x 11 size(Default). Will the printer be able to output at the 11 x17 size of the 2 – 8.5 x11s spreads. Not finding much in the way of easy fix.

I’m using CC2019.

Thanks very much in advance.

Cheers,

Paul
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            Kippy Spilker September 30, 2020 at 1:33 am #

                        
                Hi Paul. Well shoot, I thought I had the answer, got all the way to the end and Adobe basically said, “Oh, hey, sorry. You were really clever to get this far, but we’ve disabled this option. Thanks for playing.” haha. Basically I was trying to take a 4-page 8.5 x 11 and “print” as multiple (2×2) on tabloid horizontal, and then for the printer type, I chose pdf. That SHOULD have worked, but it didn’t in CC2020 – not sure if it was disabled before 2019, but you could maybe give that a shot? The only other 2 options I can come up with, and I am not crazy about either of them, is 1) To let your printer know what’s going on, so they can adjust on their end (they should have much more sophisticated pagination software that can handle this scenario) or 2) To lose a generation in quality, import your pdfs into a 2-page 11×17 InDesign document, and re-export. I guess if you’re working from Illustrator, you’re hopefully dealing with vector graphics, so the loss should be fairly negligible. Neither situation is elegant, but hopefully one of them will work. Please let me know what you decide to do. – Kippy
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            Kippy Spilker September 30, 2020 at 1:35 am #

                        
                I should add, in response to your question about “will the printer be able to output…” Yes, I certainly think they should be able to. But I think you’d need to let them know, because it may not automatically open up on their end looking like the spread you’ve created. It’ll still show as the 4 separate pages.
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            Paul September 30, 2020 at 3:14 pm #

                        
                Thanks very much for your help with this. At this moment I am sending some test pdfs to our printer to see if he can print the 2 page spreads I have created from the 4 pages. I hope he can sort it out!!! I will let you know how it turns out. As you state since it is a pdf they will be able to print with their software, but I am sure it will come at a cost if they have to play around with it. In case you are wondering why this is necessary, the original document was created as an 11x 17 handout for clients, but that format doesn’t work for the downloadable version on our website. The programmers want 4 separate pages now!! I actually came up with a half decent way of dealing with it. I created 4 – 8.5 x 11 artboards, non bleed document and butted them together.Then added the graphics to each artboard. Then I created 2 -11 x 17 artboards and aligned them underneath the first 4 artboards. I create a a hires pdf which has the 6 pages. With this pdf I then just save 1 version with the printer spreads for the printer and another with the 4 pages for the web version.

But I will wait to see if it’s an easy fix from the printer with the file I created with your solution first!!

Thanks again!!

Cheers,

Paul
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            Julia November 23, 2020 at 12:03 pm #

                        
                Thank you! The instructions were easy to comprehend even as a non native english speaker.
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            Kippy Spilker December 11, 2020 at 12:44 am #

                        
                You are very welcome, Julia. Glad I could help. 🙂
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            Mike December 28, 2020 at 9:39 pm #

                        
                Hi Kippy,

I’m so glad that I found your page because you clearly explained EXACTLY what I need to do.

I followed your easy instructions, but nothing happened – it did not work… Any recommendations?
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            Kippy Spilker January 8, 2021 at 1:22 am #

                        
                Hi Mike. Sorry, I missed this comment when it came in, and I’m probably too late now, but without knowing exactly where the problem occurs, I wouldn’t know where to start in trying to help. 🙁
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            Christy Anderson January 20, 2021 at 7:25 pm #

                        
                Didn’t work for me either. I’ve been doing this when saving IND files to PDFs, but this didn’t work in changing one PDF to another PDF. 🙁 I assume Adobe thought this was too convenient and removed the functionality.
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            Kippy Spilker February 5, 2021 at 4:21 pm #

                        
                Hm, unfortunately if I’m not sitting right there with you while you’re doing it, I can’t help with any troubleshooting. But it looks like it is still working for some, so … maybe software versions are the issue? Don’t know, sorry!
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            Jeannie deMurias January 8, 2021 at 10:26 pm #

                        
                Hello this trick in Acrobat worked! The problem is that when I upload my magazine-style pdf to a google drive for viewing it goes back to single page layout…..?
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            Kippy Spilker February 5, 2021 at 4:20 pm #

                        
                Hmm. I think maybe the person/people viewing will have to choose a 2-page layout view in order to view it properly, or it will have to uploaded to a magazine-view program.
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            Carina February 5, 2021 at 2:42 pm #

                        
                Thank you very much Kippy! so many hours you have saved me. Greetings from Portugal
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            Kippy Spilker February 5, 2021 at 4:22 pm #

                        
                So very welcome,Carina! I’m so glad this worked for you and was so helpful – yay! 🙂
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            Sacha March 10, 2021 at 7:27 pm #

                        
                Just wanted to add to the legions of grateful editors on this thread! Thank you!!!
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            Kippy Spilker March 11, 2021 at 2:27 am #

                        
                Haha. You’re welcome. Glad it was helpful! 🙂
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            Jessica March 11, 2021 at 8:32 pm #

                        
                This was amazingly helpful! Thank you, thank you, thank you!
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            Kippy Spilker April 24, 2021 at 7:18 pm #

                        
                Very welcome! Glad it helped. 🙂
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            alica March 11, 2021 at 11:13 pm #

                        
                Hi!! i did that, but at the moment when I export it, it came out again as single pages, can you help me with that? because I want it to share my pdf but as spreads
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            Kippy Spilker April 24, 2021 at 7:19 pm #

                        
                Sorry, I didn’t see this comment for quite a while. Hope you figured out the solution. 🙂
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            Mike April 4, 2021 at 4:00 pm #

                        
                Hi

Got it to work great, but when I go to print the two A5 pages side by side I have a fine white line, not butting up down the middle have I not done it correct

Mike
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            Kippy Spilker April 24, 2021 at 7:19 pm #

                        
                Not sure about printing, sorry! Hope you got it figured out. 🙂
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            Klaus May 19, 2021 at 7:00 pm #

                        
                Thanks, Kippy, for your diligent efforts on these PDF/Acrobat topics!

I have the same problem as others above: combining single-page PDFs into files with normal right-left spreads. Alas, the solution you gave does NOT work — when viewing files in Full Screen mode (Ctrl-L). It only works when all the other GUI-gunk in Acrobat is displayed. Do you have a solution for this?

Thanks!
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            Kippy Spilker June 17, 2021 at 5:45 pm #

                        
                Hi Klaus. Man, I’m terrible at monitoring this blog, I’m sorry. But it doesn’t much matter, because I don’t have any other suggestions than the ones I gave in the post, sorry! The truth is, with every single update, Adobe changes so many things – what might have worked before might not work now, and vice-versa. Hard to keep up. 🙁 Sure hope you can find a good solution for your situation.
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            Tyler June 18, 2021 at 2:25 pm #

                        
                This was a big, big help, thank you so much.
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            Kippy Spilker June 18, 2021 at 4:08 pm #

                        
                So very welcome, Tyler. I’m glad! 🙂
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            Amy June 21, 2021 at 6:51 pm #

                        
                Hi! I am struggling to get this to work… After I select two up continuous cover.. I select ok. Then I go to save as… when I open there is no difference? What am I doing wrong here?
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            Dave Riis December 11, 2021 at 10:32 pm #

                        
                You rüle! Thanks!

Quick tip in return, you can export files as Interactve PDFs with layers, and then in acrobat go into the layers and set print properties. So a page with a full bleed image can be set to not print the image and etc.
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            Kippy Spilker February 11, 2022 at 12:00 am #

                        
                Thanks, Dave. I try to avoid layered PDFs because they cause headaches with our prepress, but I bet if you’re just working on them for yourself and a client or something, that could come in super handy!
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            Rob Stephens January 13, 2022 at 10:12 am #

                        
                Amazing thanks – will bookmark this page!
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            Kippy Spilker February 10, 2022 at 11:58 pm #

                        
                You bet. Hope it helps. 🙂
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            bernyAlmor February 6, 2022 at 8:07 pm #

                        
                The cover, inside front cover, inside back cover, and back cover all count as four facing pages. We have our customers upload their files this way to save them the pain of figuring out how to arrange their pages into spreads for them to print correctly as a booklet trust me, it can get pretty confusing. Instead, you get to simply export your PDF and leave the page arranging to the pros!
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            Kippy Spilker February 10, 2022 at 11:57 pm #

                        
                Which is fine if you’re working with a printer or have someone else managing all your web work for you, but for my use, the magazine has already been printed, and I needed a way to make it viewable online as spreads, to be used with an online viewer.
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            Matt February 10, 2022 at 11:34 pm #

                        
                Thanks Kippy – I think they’ve changed something, as you now need to go to View > Page Display and change the options there for it to change.

Also when I export it as images it’s still in single format. Any idea how to export images as spreads?

I’ve been through a ton of different programs and nothing seems to do this!
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            Kippy Spilker February 10, 2022 at 11:54 pm #

                        
                Hi Matt. I just ran through it again using Acrobat Pro DC, and it worked just fine the way it’s written in this post. What you’re doing with View > Page Display is just changing how you view that one document you have open – it’s not something you can save. When you go through the steps I posted, it’s basically just forcing that “initial view” for anyone who opens it after that point. It doesn’t actually alter the document, as I understand it. I don’t know any way to export images as spreads. When I have to have a spread as an image, I open both pages in Photoshop and put them together that way. It’s not fast, but there might be a way to make an “action” for it. I’ve never had to do it in bulk, but if I did, that’s probably what I’d explore further. Good luck!
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Enjoy this blog? Please spread the word :)
	


 





	









	
	












	


 


 




	







